
Chapter 2

Insert, View, and 
Rubersheet Tools

Learning Objectives
After completing this chapter, you will be able to:
• Insert an image into a drawing
• Transform the coordinate system of an image
• Correlate the images in a drawing
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INTRODUCTION
This chapter aims to introduce you to the interoperability feature of AutoCAD Raster Design. 
AutoCAD Raster Design tools enable you to easily insert, manage, and view scanned drawings, 
satellite images, aerial photographs, and digital elevation models. In this chapter, you will learn 
to insert a raster image into a drawing and you will also learn to transform the image coordinate 
system while inserting it into a drawing that has a different coordinate system.

In this chapter, we will also discuss some of the most commonly used raster operations such as 
scaling, moving, and rubbersheeting the inserted images. Moreover, you will learn to control 
the display of the inserted image using the options in the RASTER DESIGN palette.   

INSERTING AN IMAGE
Sometimes we need to modify vector data or raster data. For that we need to insert these datasets 
into the drawing window of the software interface. AutoCAD Raster Design provides tools and 
options to insert raster images and drawing files in the drawing window using the Insert tool. 
The Insert tool allows you to specify the image correlation information to position, scale and 
rotate the image precisely so that every point on the image represents the true location on the 
surface of the earth. The image correlation parameters can be specified manually or by selecting 
the correlation source. Note that like the Insert tool, AutoCAD and AutoCAD MEP support 
the ATTACH command for inserting images. The procedure to insert a raster image using the 
Insert tool is discussed next.

Inserting a Raster Image Using the Insert Tool
Ribbon:		 Raster Tools > Insert & Write > Insert 
Command:	 IINSERT

To insert a raster image into your drawing, choose the Insert tool from the Insert & 
Write panel of the Raster Tools tab; the Insert Image dialog box will be displayed, as 

shown in Figure 2-1. You can use the various options provided in the Insert Image dialog box 
to search, browse and select the raster image to be inserted into your drawing. The various 
options in this dialog box are discussed next. 

In this dialog box, preview and the detailed information of the raster image are displayed on 
the right side. You can also browse for image data from the folder icons displayed on the left in 
this dialog box. Some of the options of this dialog box are discussed next.

Look in
You can choose an option from the Look in drop-down list to specify the folder or directory 
that contains the raster image. On selecting the required folder or directory, the content of the 
selected folder will be displayed in the list box below this drop-down list. 

Search the Web
You can use the Search the Web button to find and select any raster image from the 
internet. On choosing this button, the Browse the Web - Open dialog box will be displayed. 

In this dialog box, specify the name and the URL of the file to be opened in the Name or URL 
edit box and then choose the Open button; the image from the specified path will be opened. 
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Figure 2-1  The Insert Image dialog box

Files of type
This drop-down list contains the list of supported image file formats. You can choose an option 
from this drop-down list to filter the image format for selection.

Note  
AutoCAD Raster Design does not support .img file format, if you try to insert this file format, a 
message informing about an unknown format or invalid file will be displayed. 

 
File name
The File name drop-down list displays the name of the raster selected in this dialog box. This 
drop-down list also displays the path of recently used rasters. You can open a recently used raster 
by selecting an option from this drop-down list. 

Preview Area
This area displays the preview of the selected image, as shown in Figure 2-2.

Information Area
The Information area in this dialog box displays general information such as image type, size, 
density and so on of the selected raster image, refer to Figure 2-2.

Hide preview
You can use this button to toggle the display of the selected image in the Preview and Information 
area.
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Figure 2-2  The image preview displayed in the Insert Image dialog box 

Insert Options Area
Using the options in this area, you can specify the method of inserting an image in the drawing. 
You can select one of the radio buttons such as Quick insert, Insertion wizard, or Insertion dialog 
from this area to provide correlation values to your drawing. You can also specify other insertion 
options by selecting the Show frames only, Zoom to image(s), and Treat as multispectral check 
boxes to display image and zoom level. 

The various image insertion options are discussed next.

Quick insert
You can select this radio button to insert an image into the drawing. While inserting the 
image using this option, AutoCAD Raster Design uses the correlation information available 
in the image, separate correlation file, or default values specified in the AutoCAD Raster 
Design Options dialog box.

Insertion wizard
Selecting this radio button will enable you to specify additional image insertion parameters 
like correlation source, positioning values, and so on. Select an image from the selection 
area of the Insert Image dialog box. Next, select the Insertion wizard radio button and 
then choose the Open button; the Pick Correlation Source page will be displayed, as shown 
in Figure 2-3. 

In this page, you can specify the source for image correlation by selecting an option from the  
Correlation source drop-down list. If you select the Image File option from the Correlation 
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source drop-down list, you will have to provide correlation values in the Correlation Values 
area. If you select the Default Values option from the Correlation source drop-down list, 
the image will be inserted using default values provided in the image. 

In the Correlation Values area, the X and Y display boxes display the coordinate values 
for the insertion of the raster image. Also, the rotation and scale values are displayed in 
their corresponding display boxes. The values displayed in the Correlation Values area 
depends upon the option selected from the Correlation source drop-down list. Note that, 
if the inserted image is already rectified, then the rectified X and Y coordinate values will 
be displayed in the X and Y display boxes.

The value in the Density display box displays the pixel density of the raster image. The 
image unit is displayed in the Units area below the Density display box, refer to Figure 2-3. 
The Coordinate System area displays the Coordinate Reference System (CRS), if applied, 
of the selected raster image. 

On specifying the required options in this page, choose the Next button; the Modify 
Correlation Values page will be displayed, as shown in Figure 2-4. By default, the options 
in the Modify Correlation Values page will display the correlation values specified in the 
Pick Correlation Source page. 

You can use the options in this page to modify the correlation parameters for the image to 
be inserted. 

Note  
The values can be edited only in the Modify Correlation Values dialog box.

Figure 2-4  The Modify Correlation 
Values page 

Figure 2-3  The Pick Correlation 
Source page 
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To modify a correlation parameter, specify the required value in the Correlation Values 
area. For example, to modify the different image unit, select an option from the Image units 
drop-down list. To modify the scale of the image, specify the required value in the Scale edit 
box. Note that to enlarge the image, specify a scale value larger than 1 in the Scale edit box 
and to reduce the size of the image, specify a scale value between 0 and 1. 

On modifying the required correlation parameters, choose the Apply button; the modified 
correlation values will be applied to the image. Choose the Next button; the Insertion page 
will be displayed, as shown in Figure 2-5.

Using the options in the Insertion page, you can graphically or numerically specify the 
correlation parameters for inserting an image. 

To specify the parameters numerically, enter the values in the required areas as explained 
in the previous sections. Alternatively, to graphically specify the values, choose the Pick 
button in the Correlation Values area; the Insertion page will be closed and you will be 
prompted to specify the base point for inserting the image. Click on the required location 
in the drawing; you will be prompted to specify the angle of rotation of the image. Note 
that moving the cursor in the drawing will rotate the image frame attached to the cursor 
about the specified base (insertion) point. Rotate the frame to the required angle by moving 
the cursor and then click to specify the rotation angle; you will be prompted to specify the 
corner. Note that the frame of the image is now fixed on the basis of the specified insertion 
point and rotation angle. You will also notice that the size of the frame changes on moving 
the cursor. Move the cursor to choose the required frame size and then click; the Insertion 
page will be displayed. This page will now show the correlation parameters that were 
specified graphically. You can specify the color of the image frame. To do so, choose the 
Select button in the Color area of the page; the Select Color dialog box will be displayed, 
as shown in Figure 2-6.  

Figure 2-5  The Insertion page Figure 2-6  The Select Color dialog box 
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Choose the required color in this dialog box and then choose the OK button; the dialog 
box will be closed and the selected color will be displayed in the color preview box next to 
the Select button in the Color area of the Insertion page. Choose the Apply button in the 
wizard to apply the specified parameters.

Next, choose the Finish button in the Insertion wizard; the image is inserted in the drawing 
using the correlation parameters specified in the wizard.

 
Insertion dialog
This radio button will enable you to specify additional image insertion parameters. To 
insert an image; select an image from the selection area of the Insert Image dialog box. 
Next, select the Insertion dialog radio button and then choose the Open button; the Image 
Insertion dialog box will be displayed with the Source tab chosen, as shown in Figure 2-7.

The options in this dialog box are similar to the Pick Correlation Source page, as discussed 
earlier.

Figure 2-7  The Source tab of the Image Insertion dialog box 

Note  
In case you are using a GIS application like AutoCAD Map 3D as the base software for installing 
AutoCAD Raster Design, then while inserting an image having coordinate system different from 
the coordinate system assigned to the drawing, the Transform page will be displayed after the 
Modify Correlation Values page. You can use the options in this page to transform the coordinate 
system of the image.

Show frames only 
To display only the frame of the inserted image in the drawing, select the Show frames only 
check box in the Insert Image dialog box, refer to Figure 2-2.
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Zoom to image(s) 
You can select this check box to automatically zoom to the extents of the inserted image. 
This check box is cleared by default as a result AutoCAD Raster design will not zoom to the 
extents of the inserted image. 

Treat as multispectral 
This option will be activated only when two or more images are selected in the selection 
area of the Insert Image dialog box. Using this option you can insert the selected images 
as a multispectral dataset. Inserting a multispectral image into the drawing is discussed in 
detail further in this book.

Multi-frame options Area
You can select an option in this area to specify which image frame you want to insert from a 
multiframe image. A multiframe image dataset consists of multiple images within a single file. 
Note that, each image within the multiframe file has a separate frame. 

To activate this area, select a multiframe image like .ntf extension file in the selection area of 
the Insert Image dialog box. If you select the Insert first frame radio button, the first frame 
from the multiframe dataset will be displayed in the drawing. Similarly, if you select the Insert 
all frames radio button, it will insert all the image frames of the multiframe dataset. 

Note  
If the Quick insert radio button is selected in the Insert Image dialog box, AutoCAD Raster 
Design will directly insert the selected image into the drawing without prompting for any additional 
input parameters from the user.

In case you are using AutoCAD Raster Design with a GIS application such as AutoCAD Map 3D, 
AutoCAD Raster Design provides the options for coordinate transformation while inserting an 
image having coordinate system different than that of the drawing. 

TRANSFORMING IMAGE COORDINATE SYSTEM 
As discussed earlier, while inserting an image having coordinate system different than that of 
the drawing environment, AutoCAD Raster Design will display the Transform page after the 
Modify Correlation Values page, refer to Figure 2-8. 

On selecting the Insertion dialog radio button in the Insert Image dialog box while inserting 
an image in the drawing, the Transform tab will be displayed in the Image Insertion dialog 
box. Note that, before inserting the desired image, you need to assign coordinate system to the 
drawing environment, only then this tab will be displayed. 

You can use the options in the Transform tab for transforming the image coordinate system. Note 
that, to activate the options in this tab you need to select the Transform to drawing’s coordinate 
system check box in the Transform area. The options in the Transform tab are discussed next. 

Tip
If the image coordinate system and drawing coordinate system have different coordinate values, 
the image will not open in your drawing area.
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Figure 2-8  The Transform page 

Image coordinate system Area
In most cases, AutoCAD Raster Design will identify the coordinate system of the selected image 
and will display it in the Image coordinate system area of the Transform page. 

You can also specify a coordinate system for the image using the options in this area. To do so, 
enter the coordinate system code in the Code edit box. AutoCAD Raster Design will search the 
coordinate system library for the specified code. Alternatively, you can specify the coordinate 
system by selecting the required coordinate system from the library. To do so, choose the Select 
button; the Select Coordinate System dialog box will be displayed, as shown in Figure 2-9.

Figure 2-9  The Select Coordinate System dialog box 
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In the Select Coordinate System dialog box, select the required category of the coordinate 
system by selecting an option from the Category drop-down list. On doing so, the coordinate 
systems in the selected category will be displayed in the Coordinate Systems in Category list 
box. Next, choose the required coordinate system in the Coordinate Systems in Category list 
box, refer to Figure 2-9, and then choose the OK button; the code of the selected coordinate 
system will be displayed in the Code edit box of the Transform page.

In AutoCAD Raster Design, you can view the properties of the selected coordinate system. To do 
so, choose the Properties button in the Image coordinate system area; the Coordinate System 
Property dialog box will be displayed, as shown in Figure 2-10. Note that you cannot edit the 
CRS parameters using the options in the Coordinate System Property dialog box.

Figure 2-10  The Coordinate System Property dialog box 

Drawing coordinate system Area
The Drawing coordinate system area of the Transform page displays the coordinate system of 
the drawing environment. To view the properties of the drawing coordinate system, choose the 
Properties button in this area; the Coordinate System Property dialog box will be displayed, 
refer to Figure 2-10.

Transform Area
Select the Transform to drawing’s coordinate system check box in the Transform area to enable 
the transformation of the image to the drawing coordinate system. Note that, all the options in 
the Transform page will be deactivated if you clear this check box.
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You can choose the type of transformation by selecting an option from the Transform type 
drop-down list. The various options in this drop-down list are discussed next.

True (pixel by pixel)
The True (pixel by pixel) transformation type is applied to every pixel in the image. After 
applying this transformation type, the result will be more accurate. However, this is a slow process 
and requires large amount of resources for computing transformation.   

4 point rubbersheet
You can select this option to enable image transformation using 4 points on the image. This 
transformation produces the most accurate results.

3 point affine
You can choose this option to enable affine transformation of the image. An affine transformation 
can differentially scale, skew, rotate, and translate a raster image. You need atleast 3 control 
points on the image to perform this method. 
On specifying the required options in the Transform page, choose the Next button; the Insertion 
page will be displayed. 

Note  
If you select the Transform to drawing’s coordinate system check box in the Transform page, 
the options in the Correlation Value area of the Insertion page will be disabled.

In the Insertion page, specify the required options as explained earlier in the chapter and then 
choose the Finish button; the selected image will be inserted in the drawing area. 

The image inserted in the drawing is also added into the Tree View of the RASTER DESIGN 
palette. You can view the inserted image by clicking on the tree view symbol in the RASTER 
DESIGN palette. You can use this palette to view the properties of the inserted images. The 
various options in this palette can also be used to manage the raster images in the drawing. The 
various components of the RASTER DESIGN palette are discussed next. 

RASTER DESIGN PALETTE
Ribbon:		 Raster Tools > Manage & View > Manage 
Command:	 IMANAGE

The RASTER DESIGN palette in AutoCAD Raster Design is used to manage the inserted rasters 
in your drawings. Using this palette you can control the color and visibility of the image. You 
can also use this palette to view the image properties and related data.

To invoke this palette, choose the Manage tool from the Manage & View panel of the  
Raster Tools tab; the RASTER DESIGN palette will be displayed, as shown in Figure 2-11. 

The options and areas in the RASTER DESIGN palette are discussed next.
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Figure 2-11  The RASTER DESIGN palette 

Management Toolbar
You can select the Image Insertions option from the Image view drop-down list. On doing so, 
the Image Insertions view will be displayed in the RASTER DESIGN palette. You can also 
display the Image Data view in the RASTER DESIGN palette by choosing the Image Data 
option from the Image view drop-down list.

The Management toolbar in the RASTER DESIGN palette contains buttons that can be  
used to control the display of the items. You can use the Expand Tree button to display 
the hierarchy of objects in the Tree view. You can use the Collapse Tree button to hide  
the hierarchy in the Tree view.  

You can either display the image preview or the data related to the image as a table in the 
Item view of the RASTER DESIGN palette. To do so, choose the Show Image Preview 
button in the Management toolbar.  

Note that on right clicking in the Item view area of the RASTER DESIGN palette, a shortcut 
menu will be displayed. The options displayed in this shortcut menu will depend on the option  
selected such as Image Insertions / Image Data in the Image view drop-down list. You can use 
the options in the shortcut menu to manage the images in the drawing. 

Tree View
The tree view in the RASTER DESIGN palette displays the list of images in the drawing in 
a hierarchical view. Figure 2-12 shows the Tree view in the RASTER DESIGN palette in the 
Image Insertions view.
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Figure 2-12  The Tree view in the RASTER DESIGN palette 

Item View
The Item view in the RASTER DESIGN palette displays the properties of the selected image in 
a table. You can define the display and order of the columns in the table. To do so, right click on 
the column name in the Item view; a shortcut menu will be displayed, as shown in Figure 2-13. 
Next, choose any option from the shortcut menu. On doing so, the columns related to the 
selected option will not be displayed in the Item view area.

You can display the preview of the selected image in the Item view of the RASTER
DESIGN palette. To do so, ensure that the Image Insertions option is selected in the 
Image view drop-down list. Next, choose the required image from the Tree view and then choose 
the Show Image Preview button from the Management toolbar; the preview of the selected 
image in the Tree view will be displayed in the Item view, as shown in Figure 2-14.

Note  
You can toggle between the table and image view in the Item view of the RASTER DESIGN 
palette only if you have selected the Image Insertions view option from the Image view drop-down 
list in the Management toolbar. 

As discussed earlier, you can manage the inserted images in the drawing using the options in the 
Image Insertions view and Image Data view of the RASTER DESIGN palette. These options 
are discussed next. 
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Figure 2-13  Shortcut menu displayed on right clicking in the Item view of 
the RASTER DESIGN palette 

Image Insertions View
To display the Image Insertions view, choose the Image Insertions option from the Image  
view drop-down list in the RASTER DESIGN palette. In this view, you can display the table or 
image preview in the Item view as discussed earlier. 

You can also use this view for managing image insertions and their color maps. To do so, expand 
the drawing name node in the RASTER DESIGN palette; the tree view will display a list of 
images inserted in the current drawing, refer to Figure 2-14. Next, right click on the required 
image name; a shortcut menu will be displayed, as shown in Figure 2-15. The various options 
in this shortcut menu are discussed next.

Properties Option
You can choose the Properties option from the shortcut menu to display the properties of the 
selected image in the PROPERTIES palette. Figure 2-16 displays the PROPERTIES palette 
showing properties of a raster image. 

Edit Color Map Option
You can choose the Edit Color Map option from the shortcut menu to edit the color map for 
the selected image. To do so, ensure that the Image Insertions option is selected in the Image  
view drop-down list of the RASTER DESIGN palette. Next, right-click on the required image; 
a shortcut menu will be displayed, refer to Figure 2-15. Choose the Edit Color Map option from 
the shortcut menu; the Image Adjust dialog box will be displayed, as shown in Figure 2-17. You 
can specify various image parameters using the options in this dialog box.



Insert, View, and Rubersheet Tools		                                                             2-15

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 2-14 The Item view in the 
RASTER DESIGN palette displaying 
the preview of the selected image 

Figure 2-15  The shortcut 
menu displayed in the Image 
Inser t ions  v i ew  o f  t h e 
RASTER DESIGN palette

Figure 2-16  The PROPERTIES palette
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Figure 2-17  The Image Adjust dialog box

Image Adjust dialog box
Using the options in this dialog box, you can adjust the brightness, contrast, and fade values 
of the inserted image. You can adjust the image brightness by moving the Brightness slider, 
refer to Figure 2-17. Moving the slider toward the Dark end will reduce the brightness. To 
increase the brightness, move the slider toward the Light end of the slider. You can also 
specify the brightness value by entering the required value in the corresponding edit box. 
Similarly, you can adjust the Contrast and Fade values of the image by using the Contrast 
and Fade slider in the dialog box.

On specifying the required parameters, choose the OK button; the specified adjustments 
will be applied to the image in the drawing. To reset the image adjustment parameters to 
the default settings, choose the Reset button in the Image Adjust dialog box; the values 
will be reset to default.

You can also edit the color of a bitonal image. To do so, insert a bitonal image in the drawing. 
Choose the Edit Color Map option from the shortcut menu; the Select Color dialog box will 
be displayed, as shown in Figure 2-18. You can set the color in the image using the options in 
this dialog box.

Figure 2-18  The Select Color dialog box
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Select Color dialog box
In this dialog box, you can specify the required color by selecting it from the AutoCAD 
Color Index (ACI) palette in the Index Color tab, refer to Figure 2-18. 

In the True Color tab of this dialog box, you can also manually define and assign a color 
using the Hue Saturation Luminance (HSL) or the Red Green Blue (RGB) color model. 

In the Color Books tab of this dialog box, you can specify color using third-party color 
books or user-defined color books. 

Select the required color from the Select Color dialog box and then choose the OK button; the 
dialog box will be closed and the selected color will be assigned to the bitonal raster.

Zoom to Option
You can choose the Zoom to option from the shortcut menu to zoom to the extents of the 
selected image.

Hide/Show
You can choose the Hide option from the shortcut menu to switch off the display of the selected 
image in the drawing. On choosing this option the selected image will be hidden in the drawing. 
To display a hidden image, invoke the shortcut menu and then choose the Show option from 
it; the selected image will display in the drawing. 

Note  
Hiding an image will not detach (remove) the raster image from the drawing. The Hide option  
simply turns off the display of the image in the drawing.

Erase Option
You can choose the Erase option from the shortcut menu to erase the selected image from the 
current drawing. On doing so, the selected image and its frame will be deleted from the current 
drawing and from the Tree view of the RASTER DESIGN palette.

If you have selected the Always detach radio button in the User Preferences tab of the AutoCAD 
Raster Design Options dialog box, then on choosing the Erase option in the shortcut menu, the 
erased image will be automatically detached from the drawing. On the other hand, if you have 
selected the Ask before detach radio button in the AutoCAD Raster Design Options dialog 
box then on choosing the Erase option in the shortcut menu, you will be prompted to specify 
whether you want to detach the erased image. If you choose not to detach the erased image, then 
selected image will be deleted from the drawing and from the Tree view of the Raster Design 
palette, but the Tree view of the Image Data view will display an unreferenced data definition. 

Write Option
You can use the Write option in the shortcut menu, refer to Figure 2-15, to save or export the 
selected image. To do so, choose the Write option from the shortcut menu; a cascading menu 
will be displayed. Choose the required option from this cascading menu to save or export the 
selected image. 
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Capture Option
If you are unable to save or export an image, you can capture a snapshot of the image.  
To do so, choose the Capture option from the shortcut menu; the AutoCAD Raster Design 
will capture the snapshot of the selected image and will also insert it into the current drawing 
as a new insertion. Now you can save or export this snapshot as a new image. Note that, you can 
also capture the snapshot of the selected image using the Capture tool from the Insert & Write 
panel in the Raster Tools tab.

Image Display Order Options
The shortcut menu also provides various display order options such as Move forward, Move 
back, Bring to front, and Send to back, refer to Figure 2-15. You can use these options to manage 
the display order of the selected image.

Image Data
The Image Data view, refer to Figure 2-19, displays the data-centric view of the rasters in the 
RASTER DESIGN palette. You can invoke the Image Data view by selecting the Image Data 
option from the Image view drop-down list in the RASTER DESIGN palette. This view is best 
suited for working with image data definition and creating new image insertions. The Tree view 
for the Image Data view displays various objects and their symbols as given in Table 2-1.

Figure 2-19  The Image Data view in the RASTER DESIGN palette 
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Table 2-1  Symbols and their description in the Image Data view

Image data definition

Band group

Band group metadata

Data band

Color map

Image insertion

 

To perform an action such as creating a new image insertion or detaching an image in the Image 
Data view, right click on the required image in the Tree view; a shortcut menu will be displayed, 
as shown in Figure 2-20.  Next, you can select the required option from the shortcut menu. The 
options in this shortcut menu are discussed next.

Figure 2-20  The shortcut menu displayed in the Image 
Data view of the RASTER DESIGN palette

Properties Option
You can choose the Properties option from the shortcut menu to invoke the Data Definition 
dialog box. This dialog box displays the data definition information for the selected image 
insertion, refer to Figure 2-21. 

New Insertion Option
You can choose this option from the shortcut menu to create a new insertion for the selected 
raster image. On choosing this option, based on the type of raster selected in the Tree view, 
AutoCAD Raster Design will directly create a new insertion or will prompt you to specify additional 
parameters for creating the insertion. The new insertion is also displayed as a node in the Tree 
view of the RASTER DESIGN palette.
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Figure 2-21  The Data Definition dialog box

Detach Option
You can completely remove the image along with its data definition from the current drawing 
by choosing the Detach option from the shortcut menu. On doing so, the selected image is 
completely removed from the drawing and also from the RASTER DESIGN palette.

Unload/Reload Options
You can choose the Unload option from the shortcut menu to remove the selected image from 
the display. Unloading an image will remove the image from the display. To reload the unloaded 
image, you can choose the Reload option from the shortcut menu.

Browse path Option
You can invoke the Choose a New Directory dialog box by choosing this option from the shortcut 
menu. Using the options in this dialog box you can navigate to a different source file and open it.

Save path Option
Using this option, you can save the path of the file.

Clear path Option
You can choose the Clear path option from the shortcut menu to delete the saved path from 
the selected data definition.

CORRELATING INSERTED IMAGES
Images inserted without specifying correlation parameters may result in placing of those images at 
improper location or even with incorrect scale. Sometimes, images such as scanned maps or aerial 
photos are distorted which may lead to incorrect results. The use of raster images inserted at the 
correct location and scale is more important in applications such as Geographical Information 
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Systems (GIS), as it requires georeferenced data for performing spatial analysis. It is therefore 
required that you perform image rectification so that the image is placed at the required location 
with the correct scale value and is free of any distortion. This can be achieved by performing 
various raster operations such as move, scale, and rotate. AutoCAD Raster Design also provides 
the Rubber Sheet tool using which you can georeference a raster image file for further use.

Correlating raster images can be a simple process using a single image correlation operation such 
as scaling or moving raster image or it can be done using a complex procedure that requires the 
use of multiple image correlating operations. The various methods in AutoCAD Raster Design 
used for correlating images are discussed next.

Displacing an Image
Ribbon:		 Raster Tools > Correlate > Displace 
Command:	 IDISPLACE

In situations where raster image is not inserted at a required location in the drawing, you 
can use the Displace tool to move and adjust image to the required location. Note that, 

using the Displace tool will not alter the scale and rotation of the image in the drawing.

To move an image in the drawing, choose the Displace tool from the Correlate panel of the 
Raster Tools tab; you will be prompted to specify the base point for the raster image to be moved. 
Click at the required location to specify the base point for the image; you will be prompted to 
specify the destination point for moving the raster image. Click on the drawing to specify the 
displacement point; the selected raster image will be moved to the specified point. Figure 2-22 
shows the schematic representation of moving the inserted image using the Displace tool.

Note  
If a drawing contains more than one raster image, AutoCAD Raster Design will prompt you to 
select the raster to be moved, scaled, and matched.

Scaling an Image
Ribbon:		 Raster Tools > Correlate > Scale 
Command:	 ISCALE

You can use the Scale tool to change the scale of the inserted image. You can set the scale 
of an image to your desired scale value. Note that using the Scale tool will not change 

the rotation of the image in the drawing.

To change the scale of the selected image, choose the Scale tool from the Correlate panel in the 
Raster Tools tab; you will be prompted to specify the base point of the image. Click to specify 
the base point. Next, you will be prompted to specify the source distance. Specify the source 
distance by clicking on the image and then press enter. Alternatively, you can specify the source 
distance by clicking two points in the drawing. On specifying the source distance you will be 
prompted to specify the destination distance. Specify the destination distance at the Command 
prompt area; the image will be scaled as per the specified parameters, refer to Figure 2-23. 
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Figure 2-22  Moving the raster image Figure 2-23  Scaling the raster image

Matching Image Points
Ribbon:		 Raster Tools > Correlate > Match 
Command:	 IMATCH

You can use the Match tool to correlate a raster image by matching points between two 
images or between an image and the vector (CAD) data in the drawing. The Match tool 

moves, rotates, and scales the selected raster images so that the points specified on the source 
image coincide with the points specified on the destination data.

To correlate a raster image using the Match tool, choose it from the Correlate panel of the 
Raster Tools tab; you will be prompted to specify the source point1 on the raster to be correlated. 
Click on the required point to specify the first source point; you will be prompted to specify the 
destination point corresponding to the first point. Click on the drawing to specify the destination 
point; you will be prompted to specify the second source point. Select the second source point 
by clicking on the required point on the raster to be correlated; you will be prompted to specify 
the corresponding destination point. Click on the drawing to specify the destination point; the 
selected raster will be moved, scaled, and rotated so that the specified source and destination 
points match each other. Figure 2-24 shows the process of correlating a raster image using the 
Match tool.  

Figure 2-24  Correlating the raster image using the Match tool
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Rubbersheeting an Image
Ribbon:		 Raster Tools > Correlate > Rubber Sheet
Command:	 IRSHEET

Sometimes you need to correct your raster images to remove distortion from the image. 
Distortion in the image can be parallax error, lens distortion, and unevenness of the 

terrain. Rubbersheet uses control points to match the source point and destination point in the 
drawing to remove such distortion. 

The image correlation tools such as the Displace, Match, and Scale are useful in correlating 
images but are unable to remove distortion in the image. You can use the Rubber Sheet tool in 
AutoCAD Raster Design to correlate the inserted raster image in the drawing. Using this tool 
for image correlation, you can rectify most of the distortions in an image.

To correlate a raster image, choose the Rubber Sheet tool from the Correlate panel of the 
Raster Tools tab; the Rubbersheet - Set Control Points dialog box will be displayed, as shown 
in Figure 2-25. 

Figure 2-25  The Rubbersheet - Set Control Points dialog box

Using the options in this dialog box, you can specify the set of points that provide the matching 
points between the image and the drawing. These matching points, known as control points, can 
be selected by picking source and destination points in the drawing. They can also be specified 
by using a grid of destination points. After specifying the control points, you will have to select 
the method of image transformation. AutoCAD Raster Design offers two methods for image 
transformation: Triangular method and Polynomial method. On selecting the transformation 
method, AutoCAD Raster Design will use the specified control points and selected image 
transformation method to rubbersheet the image. 

The options in the Rubbersheet - Set Control Points dialog box are discussed next.
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Method Area
The Method area in the Rubbersheet - Set Control Points dialog box contains options for 
selecting the image transformation method. As explained earlier, AutoCAD Raster Design can 
transform an image using the Triangular or Polynomial transformation method. To choose the 
Triangular image transformation method, select the Triangular radio button in this area or 
choose the Polynomial radio button to use the Polynomial image transformation method. These 
transformation methods are briefly discussed next.

Triangular Image Transformation
In the Triangular image transformation method, AutoCAD Raster Design creates triangular 
regions within the raster image using the control points specified by the user. To create the 
triangular regions, AutoCAD Raster Design uses the Denaulay Triangulation method. Next, 
transformation is applied to each triangular area resulting in a more accurate transformation 
than the polynomial image transformation method.

This method applies transformation to only that part of the image which lies within the 
area defined by the Denaulays triangulation. The portion of the image lying outside the 
triangulation is not transformed. As a result, AutoCAD Raster Design discards the image 
data outside the triangulated area which leads to the loss of  data. To minimise the loss of 
data, ensure that the control points are placed as close to the image extents as possible. 

Polynomial Image Transformation
The Polynomial image transformation method transforms the entire image by matching 
the source and destination points as close as possible. As the transformation is applied on 
the entire image, this method does not result in loss of image data. However, this method 
does not always result in perfectly matched source and destination points. The positional 
error between the actual destination point (destination point on transformed image) and 
the destination point specified by the user is given by:

Positional error = √ (∆x + ∆y)

You can specify the polynomial degree in the Degree edit box corresponding to the Polynomial 
radio button. You have to specify more numbers of control points in the entire image if higher 
polynomial order is selected. The minimum number of control points for polynomial orders 
are as follows:

		  Polynomial Orders	 Minimum Number of Control Points
			   1				    3
			   2				    6
			   3				    10
			   4				    15
			   5				    21

Note  
The Degree edit box will be activated only when you select the Polynomial radio button and had 
specified minimum six control points. 

Note that, a higher polynomial degree will increase the positional accuracy of the image points 
at the matching locations (source point and destination points).
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Add Points
You can choose the Add Points button to specify the control points by selecting the source and 
destination points. On choosing this button, the Rubbersheet - Set Control Points dialog box 
will be closed and you will be prompted to select the first source point. Select the source point 
on the image by clicking at the required point; you will be prompted to specify the destination 
point for the selected source point. Click on the required location in the drawing; you will be 
prompted to select the next source point. Continue specifying the required number of control 
points. To end specifying control points, press ENTER; the Rubbersheet - Set Control Points 
dialog box will displayed. 

Note that the control point table in the dialog box displays ID of the control points, coordinates of 
the source and destination points in the control point, and positional error of the control points. 
Figure 2-26 displays a list of control points in the Rubbersheet - Set Control Points dialog box.

Figure 2-26  The Rubbersheet - Set Control Points dialog box displaying list of control points

Grid Points
You can choose the Grid Points button from the Rubbersheet - Set Control Points dialog box 
to invoke the Grid Parameters dialog box, as shown in Figure 2-27. Using the options in this 
dialog box, you can create a grid of destination points and then use them to specify the control 
points for image transformation.

Figure 2-27  The Grid Parameters dialog box
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Specifying the Control Points Using the Grid of Destination Points
In this dialog box, specify the required number of rows and columns in the Rows and 
Columns edit boxes, respectively. Note that on doing so, the Total option below the Column 
edit will display the total number of control points.
 
Next, specify the x and y coordinates of the grid origin in the X Origin and Y Origin edit 
boxes, respectively. Alternatively, you can specify the grid origin by picking a point in the 
drawing. To do so, choose the Pick button in the Grid area of the dialog box. On choosing 
this button, the Grid Parameters dialog box will close and you will be prompted to specify 
the grid origin. Click on the required point in the drawing; the Grid Parameters dialog 
box will be displayed again. Note that the X Origin and Y Origin edit boxes in the dialog 
box now display the coordinates of the selected point. 

Next, specify the values for the column and row spacing of the grid in the X Size and Y 
Size edit boxes, respectively. Alternatively, you can graphically specify the row and column 
spacing in the grid. To do so, choose the Pick button in the Cell area of the dialog box; the 
Grid Parameters dialog box will close and you will be prompted to specify the first corner 
point of the grid cell. Click on the drawing to specify the first corner point. On doing so, 
you will be prompted to specify the second corner point. Click on the drawing to specify the 
point. On doing so, the Grid Parameters dialog box will be displayed again. Note that the 
X Size and Y Size edit boxes in the dialog box will now display the values corresponding 
to the dimensions of the cell size specified graphically.

After specifying the parameters for creating the grid, you can preview the grid by choosing 
the Preview button. Next, to specify the control points using the points in the grid as the 
destination points, choose the Add points button in the Grid Parameters dialog box; the 
dialog box will close and you will be prompted to specify the source point corresponding to 
the selected destination point in the grid. Select the source point on the image by clicking 
on the required point; AutoCAD Raster design will select the next point in the grid and will 
prompt you to select the corresponding source point. 

Continue specifying the source point for all the destination points in the grid. After the source 
points for the destination points in the grid are specified, the Rubbersheet - Set Control Points 
dialog box will be displayed again.   

Delete
You can choose the Delete button to remove (delete) a control point from the Rubbersheet - Set 
Control Points dialog box. Note that the Delete button will be activated only after you select a 
control point from the control point table.

Repick
You can choose the Repick button to edit an existing control point. To do so,  select the required 
control point from the control point table in the Rubbersheet - Set Control Points dialog box; 
the Repick button will be activated. Choose this button; the Rubbersheet - Set Control Points 
dialog box will be closed and you will be prompted to specify the source point for the selected 
control point. Click on the drawing to specify the source point for the control point; you will be 
prompted to specify the destination point for the control point. Click on the drawing to specify 
the destination point; the Rubbersheet - Set Control Points dialog box will be displayed with 
the updated source and destination point for the selected control point.
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Tip
To edit multiple control points, select the required control points in the Rubbersheet - Set 
Control Points dialog box and then choose the Repick button. On doing so, you will be 
prompted to specify the source and destination points for the selected control points. 

Preview
You can preview the result of rubbersheet by choosing the Preview button from the 
Rubbersheet - Set Control Points dialog box. On choosing the button, the dialog box will close 
and the preview of the rubbersheet will be displayed in the drawing window. To end the display 
of preview, press ENTER.

Import
You can import a set of control points that are saved in a text (.txt) file. To do so, choose the 
Import button from the Rubbersheet - Set Control Points dialog box; the Import dialog box will 
be displayed. Use the options in this dialog box to browse and choose the text file that contains 
list of the saved control points. Next, choose the Open button; the Import dialog box will close  
and list of control points will be displayed in the control points table of the Rubbersheet - Set 
Control Points dialog box.

Export
You can also save the control points that are specified in the control points table of the 
Rubbersheet - Set Control Points dialog box as a text file. To do so, choose the Export button; 
the Export dialog box will be displayed. In this box, specify the path and name of the text file 
into which you want to export the control points and then choose the Export button, the control 
points will be exported to the specified file.
  
Auto zoom
You can select the Auto zoom check box to enable AutoCAD Raster design to zoom to the selected 
control point on choosing the Repick button.  

After specifying the required control points, choose the OK button; the Rubbersheet - Set Control 
Points dialog box will be closed and the image will be transformed using the specified options.

TUTORIAL
Before starting the tutorials, you need to download and save the tutorial files on your computer. 
To do so, follow the steps given below:

1.	 Navigate to C drive in your system and create a folder with the name AutoCADRasterDesign2017.

2.	 Download the c02_rd_2017_tut.zip file from http://www.cadcim.com. The path of the file is as 
follows: 

       Textbooks > Civil/GIS > AutoCAD Raster Design> Exploring AutoCAD Raster Design 2017
    



2-28 						      Exploring AutoCAD Raster Design 2017
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

3.	 Now, save and extract the downloaded folder at the following location: 
 
	 C:\AutoCADRasterDesign2017

Notice that c02_rd_2017_tut folder is created within the AutoCADRasterDesign2017 folder.

Tutorial 1	               Insert and Rubbersheet Raster Image
In this tutorial, you will start the AutoCAD Raster Design application and then insert a raster 
image using the Insert tool. Figure 2-28 shows the raster image to be inserted. Next, you will 
specify the control points for rubbersheeting the raster image. You will also export list of the 
specified control points as a text file. 			                       (Expected time: 30 min)

Figure 2-28  The Newark (New Jersey-New York) area toposheet

The following steps are required to complete this tutorial:

a.	 Start the base application and open the drawing file.
b.	 Insert the raster image. 
c.	 Rubbersheet the raster image.
d.	 Save the drawing file and the correlated raster image.

Starting the Base Application and Opening the Drawing File
1. 	 Start AutoCAD Raster Design and then choose the Open button from the Application menu; 

the Select File dialog box is displayed.
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2.	 In this dialog box, browse to the location C:\AutoCADRasterDesign2017\c02_rd_2017_tut\
c02_tut01, select the c02_Tut01.dwg file and then choose the Open button. Drawing file 
with UTM27-18 coordinate system assigned is opened.

Inserting the Raster Image
In this section you will learn to insert a raster image into the drawing using the Insert tool of 
AutoCAD Raster Design.

1.	 Choose the Insert tool from the Insert & Write panel in the Raster Tools tab; the  
Insert Image dialog box is displayed.

2.	 In this dialog box, select the Insertion dialog radio button from the Insert Options area. 

3.	 Next, browse to the location C:\AutoCADRasterDesign2017\c02_rd_2017_tut\c02_tut01 from  
Look in text box and then choose the NewJersey.jpg file.

4.	 Next, choose the Open button; the Insert Image dialog box is closed and the Image Insertion 
dialog box is displayed.

5.	 Ensure that the Insertion tab is chosen.

6.	 In this dialog box, specify the correlation parameters, as shown in Figure 2-29.

Figure 2-29  The Image Insertion dialog box with 
the parameters specified for image insertion

7.	 Choose the OK button; the Image Insertion dialog box is closed and the raster image is 
inserted in the drawing using the specified settings.
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8.	 Next, enter Z in the Command prompt area and press ENTER; you are prompted to specify 
the zoom option.

9.	 Specify E and then press ENTER; the drawing will zoom to its extents. 

Note that the raster image is a topomap of the New Jersey area. It also has various markings 
showing the map grid. You will use the intersection of the 10000 meter grid lines (labeled 
in red colored numbers) to specify the control points for transforming the raster image.

Note  
You can also use the Extents tool  from the Navigation Bar to zoom to the extent of
the drawing.   

Rubbersheeting the Raster Image
In this part of the tutorial, you will rubbersheet the raster image using the Polynomial image 
transformation method. Note that you will use the grid to specify the control points for 
transforming the image. 

1.	 Choose the Rubber Sheet tool from the Correlate panel of the Raster Tools tab;  
the Rubbersheet - Set Control Points dialog box is displayed.

2.	 Choose the Grid Points button; the Rubbersheet - Set Control Points dialog box is closed 
and the Grid Parameters dialog box is displayed. 

3.	 In this dialog box, enter value for the different parameters in their corresponding edit 
boxes, as shown in Figure 2-30.

Figure 2-30  The Grid Parameters dialog box with the 
parameters for creating grid

4.	 Next, choose the Preview button in the Grid Parameters dialog box; the dialog box is closed 
and preview of the grid is displayed in the drawing area as shown in Figure 2-31.

Note  
The grid is displayed in white color by default. You can change the grid color by choosing Color 
of a layer from the AutoCAD Layers panel of the Home tab. 

5.	 Press the ESC key to close the preview mode of the grid.

	 Now you will specify the control points for rubbersheeting the raster image.
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Figure 2-31  The preview of the grid displayed in the drawing area

6.	 Choose the Add Points button; the Grid Parameters dialog box is closed and you are 
prompted to specify the source point as 0,0. Notice that the destination point is at the bottom 
left corner of the grid and the cursor is attached to this point, as shown in Figure 2-32.

Figure 2-32  The cursor attached to the destination point on the grid

7.	 Move the cursor to the grid intersection 1 indicated by red color on the raster image. 
Figure 2-33 shows an enlarged view of the raster at grid intersection 1. Next, click on the 
intersection; the cursor now snaps to the next point on the grid and you are prompted to 
specify the source point for the selected point.
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Figure 2-33  The enlarged view of the raster image at grid intersection 1

Tip
For precisely specifying the source point on the raster image, zoom in to the drawing. You can 
use the mouse roller to zoom in and out of the drawing. 

Note  
The source points should be specified with utmost care and precision as they affect the accuracy 
of the result while rubbersheeting. 

8.	 Similarly, click on the grid intersection 2 on the raster, as shown in Figure 2-34; you will be 
prompted to specify the source point for the next grid point. 

Figure 2-34  The enlarged view of the raster image at grid intersection 2

9.	 Continue specifying source points from grid intersection marked 3 to grid intersection 
marked 18. On specifying the 18th intersection point, the Rubbersheet- Set Control Points 
dialog box is displayed with specified control points, as shown in Figure 2-35.  
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 Figure 2-35  The Rubbersheet - Set Control Points dialog box with the list of specified control points

Note that the dialog box now displays the list of the control points and their parameters. 

Note  
The Total RMS error depends on the users precision on specifying the points in the image.

Next, you will export the specified control points as an text file.

10.	 Choose the Export button; the Export dialog box is displayed.

11.	 In this dialog box, browse to the location C:\AutoCADRasterDesign2017\c02_rd_2017_tut\
c02_tut01.

12.	  Next, specify the name NewJerseyControlPoints in the File name edit box and then choose 
the Export button; the Export dialog box is closed and the control points are exported as 
a text file to the specified location and the Rubbersheet - Set Control Points dialog box is 
displayed.

13.	 In the Rubbersheet - Set Control Points dialog box, make sure that the Polynomial radio 
button is selected and then choose the OK button; the dialog box is closed and toposheet 
is rubbersheeted.

Note  
The process of rubbersheeting is a resource intensive process and may take some time depending 
on the configuration of your computer. The progress of the process is displayed at the bottom right 
of the user interface.

Saving the File
1.	 Choose the Save As option from the Application Menu; the Save Drawing As dialog box 

is displayed. 
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2.	 In this dialog box, browse to the following location:

		   C:\AutoCADRasterDesign2017\c02_rd_2017_tut\c02_tut01  
  
3.	 In the File name edit box, enter c02_Tut01_Result.

4.	 Choose the Save button; the dialog box is closed and drawing file is saved with the name 
c02_Tut01_Result.dwg at the specified location. Also, the Save Image dialog box is displayed, 
as shown in Figure 2-36, informing you that the raster image in the drawing has been 
modified.

Figure 2-36  The Save Image dialog box

5.	 Choose the Save As button from the dialog box; the Save As dialog is displayed.

6.	 In this dialog box, browse to the following location:

		   C:\AutoCADRasterDesign2017\c02_rd_2017_tut\c02_tut01    

7.	 In the File name edit box, enter NewJerseyCorrelated.

8.	 Ensure that the JPEG File Interchange Format (*.jpg, *.jpeg) option is selected from the 
Files of types drop-down list and then choose the Save button; the Save As dialog box is 
closed and the Encoding Method dialog box is displayed, as shown in Figure 2-37.

Figure 2-37  The Encoding Method dialog box
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9.	 Choose the Maximum Quality option from the Encoding list in this dialog box and then 
choose the Finish button; the raster image is exported to the specified location.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following options can be chosen to insert a raster image into the drawing?

		  (a) Quick insert			  (b) Insertion wizard
		  (c) Insertion dialog	 	 (d) All of the above

2.	 Which of the following correlation methods result in the loss of image data due to image 
transformation?

		  (a) Triangular 			   (b) Match
		  (c) Polynomial	 		  (d) All of the above

3.	 The second degree Polynomial image transformation method requires a minimum of 
__________ number of control points to transform a raster image.

4.	 In the Triangular image transformation method, AutoCAD Raster design creates triangular 
regions using the __________ triangulation method. 

5.	 You can choose the __________ button from the Rubbersheet - Set Control Points dialog 
box to edit an existing control point.

6.	 You can use the options in the Grid Parameters dialog box to specify the parameters for 
creating grid. (T/F)

7.	 You can select the Quick insert radio button in the Insert Image dialog box to directly 
insert a selected image into the given drawing. (T/F)

8.	 AutoCAD Raster design allows you to adjust the brightness, fade, and contrast of a raster 
image. (T/F)

9.	 You can use the options in the RASTER DESIGN palette to manage the inserted rasters in 
your drawings. (T/F) 

10.	 You can choose the Scale tool from the Correlate panel of the Raster Tools tab to change 
the scale of the inserted image. (T/F)
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Review Questions
Answer the following questions:

1.	 The RASTER DESIGN palette display a list of images in the drawing in a __________ view.

2.	 To edit multiple control points in the Rubbersheet - Set Control Points dialog box you   
need to choose the __________ button. 

3.	 You can save the control points as a text file by choosing the __________ button from the 
Rubbersheet - Set Control Points dialog box.

 
4.	 The Item view in the RASTER DESIGN palette displays the properties of the selected 

image in a table. (T/F)

5.	 You can use the Pick button from the Grid Parameters dialog box to specify the control 
points using the points in the grid as the destination points. (T/F)

6.	 AutoCAD Raster Design does not facilitate you to import control points that are defined in 
an external text (.txt) file. (T/F)

7.	 You need to select an image to scale by clicking on its image frame. (T/F)

8.	 You can select a point on the image frame by using the Object Snap option. (T/F)
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EXERCISE
Exercise 1 

Download the c02_rd_2017_exr.zip from http://www.cadcim.com and rubbersheet the exr_2.jpg raster 
image, refer to Figure 2-38.                                                                     (Expected time: 30 min)                              

Figure 2-38  Image on which rubbersheet has to be performed



2-38 						      Exploring AutoCAD Raster Design 2017
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Answers to Self-Evaluation Test
1. d, 2. a, 3. six, 4. Denaulay, 5. Repick <, 6. T, 7. T, 8. T, 9. T, 10. T


